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About This Document

Intended Audience

This document is intended for the personnel who:

 Work with the NVR Station

 Know video surveillance basics

Document Versions

Version 02 (2015-04-03)

Compared with Version 01 (2014-08-30), Version 02 (2015-04-03) includes the changes described in the

following table.

Change Type Description

Feature change Added the Record Synopsis function that is exclusive to the SNK16000 series.

Editorial change Updated screenshots.

Version 01 (2014-08-30)

Compared with Version 00 (2014-06-30), Version 01 (2014-08-30) includes the changes described in the

following table.

Change Type Description

Feature change Added the functions of the SNK16000 series.

Editorial change Updated screenshots.

Version 00 (2014-06-30)

This is a draft.

Compatibility

This document only applies to Sysvideo SNK series NVR .
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1 About the NVR Station

1.1 Introduction

Sysvideo NVR Station is a complete system for device management, video surveillance, and video

recording. The NVR Station supports Open Network Video Interface Forum (ONVIF) and Real Time

Streaming Protocol (RTSP) interoperability standards. Additionally, the NVR Station features native

integration to cameras and encoders from third party manufacturers, therefore making it an open

system.

The advanced system capabilities make the NVR Station easy to use with functions like Automatically

Adding Devices and One-Click Partition and Formatting and meet various customer needs with functions

like Record Synopsis and Privacy Mask for every day security users to advanced video surveillance

users.

The NVR Station provides the following applications:

 Web-based application: NVR Station Web

 Mobile application: Mobile NVR Client (MNC)

Note

There is no difference on the user interface between the NVR Station Web and NVR Station.

NVR Station only can manage Sysvideo SNK series NVR products.

1.2 Key Features

The following table lists key features provided by the NVR Station to meet various customer needs.

Item Feature Description

Adding devices Automatically Adding

Devices

This feature allows you to quickly add cameras to your

NVR. This feature is available to all SNK series NVRs.

For details on how to use this feature, see section 5.1

"Automatically Adding the Target Camera."

Disk management One-Click Partition and Before starting a recording, you must partition and format



Item Feature Description

Formatting disks. With this feature, you can complete the two

operations with one click.

This feature is available to all SNK series NVRs.

For details on how to use this feature, see 12.3.1

"One-Click Partition and Formatting."

Viewing

Dual-Stream and Audio The NVR Station offers the ability to record the main and

secondary streams for each camera. Along with exceptional

image quality, the NVR Station can also record audio.

This feature is available to all SNK series NVRs.

Dual-Monitor Live

Viewing

SNK series NVRs can connect to two monitors, allowing

for dual-monitor live viewing.

This feature is available to all SNK series NVRs.

For feature details, see section 5.8 "Enabling

Dual-Monitor Viewing."

Note the following:

 You can enable this feature for only the SNK0800RD

series on the NVR Station.

 For the SNK16128RD, you cannot use the

dual/triple-monitor viewing feature if you already

create RAID arrays. In other words, you cannot create

RAID arrays if you already use the dual/triple-monitor

viewing feature.

Privacy Mask This feature prevents a camera from monitoring sensitive

objects or areas in a scene. When privacy masks are created

in a scene, you cannot track objects if the objects move to a

masked area. You can create up to 4 privacy masks (24

privacy blocks) for a camera.

This feature is available to all SNK series NVRs.

For details on how to use this feature, see section 5.5

"Setting Privacy Masks."

Image Flip This feature allows you to track an object continuously as it

passes beneath a camera.
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Item Feature Description

This feature is available to all SNK series NVRs.

For details on how to use this feature, see section 5.3 "PTZ

Controls."

Playback

16-Channel 1080p Video

Playback

A spectacular 1920x1080 resolution lets you see more of

your high-resolution images with pixel-for-pixel accuracy.

When you play back videos on a screen, the solution allows

you to capture more details.

The SNK0800, SNK0800RD series, and SN16000RD series

support this featuer.

The following NVRs support 9-channel 720p video

playback:

 SNK0200 series

Record Synopsis The Record Synopsis feature summarizes a recording

(extracting all the moving objects from the recording),

parses the summarized recording, and plays back all the

moving objects. This helps you quickly detect moving

objects and improves the playback efficiency.

This feature is available only to the SN16000RD series-I.

For details about how to use this feature, see section 7.2

"Record Synopsis."

Alarming

Motion Detection With this feature, an NVR can detect a change in the

position of an object relative to its surroundings.

This feature is available to all SNK series NVRs,

Notes: IP camera need to support ONVIF motion detection.

For details on how to use this feature, see section 8.1

"Motion Detection."

E-Mail Notification Alarm notification via an e-mail alert is offered as a

standard feature with all Sysvideo NVRs. You can program

an NVR to send a message to a designated address

whenever an alarm is triggered.



Item Feature Description

This feature is available to all SNK series NVRs.

For feature details, see section 12.10.11 "Mail Service."

Storage ANR The automatic network replenishment (ANR) feature

enables an IP camera to locally save records when the

connection between it and the NVR is broken and send the

records to the NVR when the connection is resumed.

This feature is available only to the SNK0200 and SNK RD

series NVRs.

For details on where to enable this feature, see section 6.3

"Setting the Recording Policy."

1.3 Major Specifications

Homing

From a single NVR, you can view and control up to 128 cameras.

WDR

This feature allows you to record greater scene details, from shadows to highlights than normal.

IR

Infrared camreas can capture objects when there is insufficient visible light to see.

Three-Megapixel Lens

The NVR Station can work with three-megapixel lenses so that you can capture stunning nad

high-resolution digital images.
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2 Installing the NVR Station

2.1 Preparations

For better user experience, your personal computer (PC) must meet the following fundamental

requirements:

 Intel® Core® 2 Duo CPU 2.0 GHz

 2 GB of memory

 Windows XP/7/8

 Google Chrome or Mozilla Firefox

Note

You are not advised to use the Windows XP operating system since Microsoft stops providing security and other updates

for Windows XP on April 8, 2014.

If you use the Windows 7 or 8 operating system and the Windows Firewall is turned on, allow the NVR Station to

communicate through the Windows Firewall.

To access an NVR using the NVR Station Web, run the Google Chrome or Mozilla Firefox as an administrator.

2.2 Procedure

Where to find the NVR Station

You can find the NVR Station in the CD-ROM of the product package. Alternatively, you can download

the NVR Station from the NVR Station Web.

To access the NVR Station Web, enter the IP address of an NVR into the address bar of a web browser

(Google Chrome or Mozilla Firefox).

Installing the NVR Station

To install the NVR Station:

1. Obtain the NVR Station installation file NVRStationSetup.exe.

Find the CD-ROM that comes with your NVR and insert it into the CD-ROM drive on your PC, and



find the NVR Client Software folder.

Alternatively, download the file from the NVR Station Web.

2. Run the NVRStationSetup.exe as an administrator.

3. Select a display language, as shown in the following figure.

4. Follow the guidelines offered by the NVR Station Setup Wizard.

Auxiliary Software

The NVR Station comes with the following auxiliary software:

 IPCSearch: is the software where you can search for video surveillance devices, change network

settings for them, reboot and upgrade them, and access their web-based management applications.

 nvrlocalplayer: is a record player.

The following figure shows the user interface of the IPCSearch.
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3 Logging In to the NVR Station

The NVR Station comes with an administrator account whose user name and password are admin and

admin123, respectively.

To log in to the NVR Station:

1. Double-click the NVR Station icon on your PC's desktop.

2. In the displayed dialog box, specify User Name and Password.

If you select Auto Login, you can skip the login procedure next time you use the NVR Station.

Additionally, the account that you used to log in to the NVR Station last time will be resumed.

If you select Full Screen, the NVR Station will be displayed in full-screen mode.

3. Click Log in.

Note

The user interfaces of the NVR Station Web and NVR Station are continuously changed. Therefore, do not be alarmed

when you find the screenshots in this document are different from actual ones. We greatly appreciate your understanding.

All the screenshots in this document are taken from the SN16000RD series-I. If you find some options are missing,

contact the NVR system administrator to check whether your NVR supports these options. If so, contact the local

authorized Sysvideo agent.



4 Adding NVRs to the NVR Station

Before using the NVR Station, add NVRs to the NVR Station.

To add an NVR to the NVR Station:

1. Click the Add NVR button near the Device List area.

2. In the displayed Login dialog box, specify parameters according to onsite conditions, as shown in

the following figure.

For the User Name and Password parameters, apply one user account of the NVR. In this

document, the administrator account is applied.

If you select Auto Connect, the NVR Station automatically connects to the NVR as soon as you log

in to the NVR Station.

For the URL parameter, enter the domain of the NVR. The following is an example.
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For details on how to obtain a domain for an NVR, see section 3.4 of SNK0000RD Series NVR

Administrator Guide.

3. Click OK.

If you cannot add the NVR, perform the following steps to address the problem:

1. On your computer, ping the NVR to check whether your computer can reach the NVR.

 If yes, go to the next step.

 If not, change the network settings of your computer and try to add the NVR again.

2. Check whether the user account information is correct.

 If yes, go to the next step.

 If not, enter the user account information and try to add the NVR again.

3. Check whether the value for the Port Number parameter is the same as that for the NVR Station
Port parameter. (To find the location of the NVR Station Port parameter, choose Main Menu >

Network > System Ports > NVR Station Port on the on-screen display (OSD) of the NVR.)

 If yes, contact the local authorized Sysvideo agent.

 If not, correct the value for the Port Number parameter and try to add the NVR again.



5 Live Viewing

5.1 Automatically Adding the Target Camera

You can use the Automatically Adding Devices feature to add the target camera that is monitoring the

target site to your NVR.

Working principle of the feature

This feature automatically adds a camera to an NVR when the following conditions are true:

 The registration address of the camera is 224.1.1.1 (the default registration address).

 The camera is located on the same subnet as the NVR.

 The Auto Networking feature is enabled on the camera side.

For details on how to enable this feature on the camera side, see the related document of the

camera.

Alternatively, this feature can add the camera to the NVR when the following conditions are true:

 The registration address of the camera is one IP address of the NVR. (This indicates that the

camera has registered with the NVR.)

 The camera can reach the NVR.

This feature can also retrieve a camera that registered with the NVR but was preempted by another NVR

later if the following conditions are true:

 The camera is still on the camera list of the NVR.

 The camera is located on the same subnet as the NVR.

After the target camera is added to your NVR, you can find the camera on the camera list. Then, drag the

target camera to a view window on the main screen of your NVR to monitor the target site.

Note

The registration address of a camera is one IP address of the NVR to which the camera registers.

Querying the registration address of a camera

You can use IPCSearch to query the registration address of a camera. The following is an example.



15

IPCSearch is incorporated into the NVR Station. IPCSearch only can find specific series devices that are

located in the same broadcast domain as your personal computer (PC). It don’t support ONVIF camera

searching.

How to use this feature

To use this feature:

1. Right-click the NVR and choose Add/Delete, as shown in the following figure.



2. At the bottom of the Add tab page, click Auto Add, as shown in the following figure.
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After performing the preceding steps, find the target camera from the camera list of the NVR and drag

the target camera to a view window to monitor the corresponding site.

If you do not want to use this feature, you can manually search for and add the target camera. For details,

see section 5.2.1 "Adding Cameras."

Note

The Video Stitching and Patrol Specific Area features are available only to the SNK16000 Series.

5.2 Manually Adding, Editing, Replacing, and Deleting Cameras

5.2.1 Adding Cameras

To manually add a camera:

1. Move your cursor to the NVR and click the Add/Delete Device button, as shown in the

following figure.

2. On the Add tab page, click Search to search for the cameras that have registered with the NVR, as

shown in the following figure.



3. Select the camera from the search results and click Add.

4. (Optional) Under Search for a Device, specify the Device Type and IP parameters to add an RTSP

or ONVIF camera.

The following is an example.

After the preceding operations are performed, the camera is added to the camera list of the NVR.

5.2.2 Editing Cameras

To change the network settings of a camera:

1. On the Add tab page shown in step 2 of section 5.2.1 "Adding Cameras", select the camera from

the search results and click Change IP Address.
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2. In the displayed dialog box, change parameter values as required.

3. Click OK.

Note that you can change the network settings only for cameras that use the factory defaults.

To change the sequence of a camera on the camera list of the NVR:

1. Right-click the NVR and choose Sort Device, as shown in the following figure.

You can sort devices by the name, number, or ID.

You can also change the camera sequence tailored to your needs. If required, see step 2.

2. (Optional) Click Custom and change the sequence of the camera using the Move Up and Move
Down buttons, as shown in the following figure.



3. Click OK.

5.2.3 Replacing Cameras

To replace a camera:

1. On the Add tab page shown in step 2 of section 5.2.1 "Adding Cameras", select the camera from

the search results and click Replace.

2. In the displayed dialog box, select an old device.

The following is an example.

3. Click OK.
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5.2.4 Deleting Cameras

To delete a camera:

1. On the Device window shown in step 2 of section 5.2.1 "Adding Cameras", click the Delete tab.

2. Select the camera from the device list and click Delete.

The following is an example.

3. In the displayed dialog box, click Yes to confirm your operation.

5.3 PTZ Controls

When you are monitoring a site, you can use PTZ controls to look around your surveillance site.

PTZ controls are described as follows:

Option Description

Zooming
Click for near focus and for far focus.



Option Description

Adjusting the P/T speed
Adjust the speed bar to change the P/T speed.

The icon indicates a slow P/T speed while the icon indicates a fast P/T

speed.

Patrolling and Touring

Presets

To start a patrol:

1. Click the More button under PTZ Control, as shown in the following

figure.

2. Click to start a patrol, as shown in the following figure.

Before tour presets, ensure that preset positions are configured.
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Option Description

To configure a preset position:

1. Move the camera in question to a location using arrow buttons (

) under PTZ Control.

2. Enter a digit in the text box shown in previous step 2 to create a preset

position ID. Alternatively, you can choose an existing digit.

3. Click the Save button.

When preset positions are configured, click to start touring preset
positions, as shown in the following figure.

Configuring image

settings

On the second page of PTZ Control, configure image settings, as shown in the

following figure.



Option Description

Configuring the

following:

 Shutter

 Gain

 Day/night mode

 WDR

 White balance

On the third page of PTZ Control, configure the shutter, aperture, and gain, as

shown in the following figure.

You are advised to apply the default settings. If you change the value for a

parameter, click Setting to confirm your operation.

If you find an option is gray, it indicates that this option is not supported by the

target camera.

Configuring the

following:

 Aperture

 Focus

 Zoom speed

 Rotate image

 IR

 Backlight

On the fourth page of PTZ Control, you can see the following:
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Option Description

For the Rotate Image function:

Each time you select 90° Clockwise and Setting, the image will be rotated 90°

clockwise.

Each time you select 90° Counterclockwise and Setting, the image will be rotated

90° counterclockwise.

Configuring the

following:

 Wiper

 Image flip

On the fifth page of PTZ Control, you can see the following figure.

For the Image Flip function, select Horizontal and Setting to horizontally flip the

video image 180°; select Vertical and Setting to vertically flip the video image

180°.

Note

If you find an option is gray and you are sure that this option is supported by the target camera, contact the local

authorized Sysvideo agent.

5.4 e-PTZ

The electronic PTZ (e-PTZ) function allows you to digitally zoom in or out.

To use the e-PTZ function:



1. On a view window, click the E-PTZ button, as shown in the following figure.

2. Draw a square on the view window, as shown in the following figure.

3. (Optional) Click the hand-shaped button to move the video image up, down, left, or right.

4. Click the view window to return to the normal image size.

5. Click the E-PTZ button again to disable the e-PTZ function.

5.5 Setting Privacy Masks

The privacy mask feature prevents a camera from monitoring sensitive objects or areas in a scene.
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When privacy masks are created in a scene, you cannot track objects if the objects move to a masked

area. Therefore, you are advised to disable this function when you are tracking moving objects.

You can create up to 4 privacy masks (24 privacy blocks) for a camera.

To create a privacy mask, do as follows:

1. On a view window, click the Settings button, as shown in the following figure.

2. Click Privacy Mask, select Enable Privacy Mask, and select the fields to be masked.

The following is an example.



3. Click Save.

After the preceding steps are performed, you will find that masked fields turn black, as shown in the

following figure.

5.6 Changing and Touring Surveillance Sites

To change the surveillance site, drag another camera from the device list to the current view window.
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To tour multiple surveillance sites on a view window, do as follows:

1. On a view window, click the Tour Camera button, as shown in the following figure.

2. On the Tour Camera window, click Add to add a touring scheme, as shown in the following figure.



3. In the Add Scheme dialog box, enter a name for the new touring scheme.

The following is an example.

4. Click OK.

5. Drag cameras to the camera list and enter a dwell time.

The following is an example.

6. Click Start and then Close.

After the preceding steps are performed, live videos from these surveillance sites are toured on the view

window.

5.7 Setting and Touring Screen Layouts

When multiple view windows are displayed on the main screen, you can set the screen layout, create a
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screen layout scheme with cameras bound to view windows, and tour screen layout schemes.

To set the screen layout for your PC, select one screen layout from the button bar on the View tab page,

as shown in the following figure.

To set the screen layout for the NVR:

1. Right-click an NVR and choose Screen Layout.

2. In the Screen Layout window, select a screen layout and drag cameras to view windows, as shown

in the following figure.

3. Close the window.

Note

Before setting the screen layout for the NVR, ensure that no user logs in to the NVR. If any user logs in to the NVR, the

preceding steps fail.

To create a screen layout scheme with cameras bound to view windows:



1. Determine a screen layout and drag cameras to view windows.

2. Click the Screen Layout Scheme button, as shown in the following figure.

3. In the Screen Layout Scheme dialog box, click Add to add a screen layout scheme, as shown in

the following figure.

4. In the displayed Add dialog box, enter a name for the new layout scheme.

The following is an example.

5. Click OK.

6. Click the Obtain the Current Screen Layout button to load the current screen layout to the
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newly created layout scheme.

The following is an example.

Repeat the preceding steps several times to create multiple screen layout schemes.

To tour screen layout schemes, do as follows:

1. On the Screen Layout dialog box, select layout schemes to be toured and enter a dwell time.

The following is an example.



In this step, you can change the order for each scheme using the Move Up and Move Down
buttons. Additionally, you can rename a layout scheme.

2. Click Start and then Close.

5.8 Enabling Dual-Monitor Viewing

Note that you can enable dual-monitor viewing for only the SNK0800RD series on the NVR Station.

The NVR supports dual-monitor viewing using a VGA port and an HDMI port.

To enable dual-monitor viewing for an NVR:

1. Move your cursor to the NVR and click the Settings button, as shown in the following figure.

2. On the System Settings window, click the General tab.

3. Deselect the Disable the secondary screen option, as shown in the following figure.
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4. Click Save.

5. Right-click the NVR and choose Screen Layout.

6. In the Screen Layout window, select a screen layout with two digits, for example, .

The following is an example.



The button indicates that the main screen is selected. The button indicates

that the main screen is not selected.

The button indicates that the secondary screen is selected. The button

indicates that the secondary screen is not selected.

7. When the main screen is selected, drag cameras to view windows on the main screen.

8. When the secondary screen is selected, drag cameras to view windows on the secondary screen.

If more than 32 ONVIF cameras are connected to the NVR, you must select the Disable the secondary
screen option.

Note

The Disable the secondary screen option is available only to NVRs that support more than 32 cameras.

5.9 Snapshots

5.9.1 Capturing

You can capture video images locally (on the NVR Station) or remotely (on the NVR). When you capture

such images locally, the snapshots are saved on your PC. When you capture such images remotely, the

snapshots are saved on the NVR.

To capture video images locally, click the Local Snapshot button at the bottom of a view window,
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as shown in the following figure.

To capture video images remotely:

1. Right-click a camera and choose Snapshot, as shown in the following figure.

Then, you will see the following.



2. (Optional) Assign tags to the snapshot.

3. Click OK.

Note

You can capture video images remotely only for SNK enterprise NVR.

To schedule a capturing task through alarm linkage:

1. Right-click an NVR and choose Alarm > Service Alarm.

2. Select an alarm type from the Alarm Type drop-down list.

3. Select a source, day, and period.

4. Select a camera to be linked.

5. Select the Snapshot action.

6. Click Save.

The following is an example.
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The following table provides the description for each action.

Action Description Remarks

Recording Start a recording. -

Snapshot Take snapshots.

This option is not available to some models.

To configure snapshot

settings, right-click the

NVR and choose

Settings > Record and

Snapshot > Snap.

Text Overlay Display the duration the alarm persists.

When the alarm is cleared, regardless of whether

manually or automatically, the duration disappears.

-

Live View in First Assign the top left view window to the linked camera,

allowing you to live view video immediately after an

-



Action Description Remarks

Window alarm is generated.

Preset Position Invoke a preset location, allowing you to point the

linked camera at the preset location upon the

generation of an alarm.

For details on how to configure a preset location for a

camera, see section 5.3 "PTZ Controls."

The numbers of preset

locations supported by

cameras vary according to

the camera type.

Link to NVR Station Display an alarm window on the NVR Station,

allowing you to be aware of an alarm when you are

not near the NVR and locally clear the alarm.

-

Full Screen Viewing View the video from the linked camera in full screen

mode on the main screen.

-

Link to Video Wall Send the video from the linked camera to a view

window on a video wall.

This option requires that a

video wall be configured.

Link to Secondary Screen

VGA

Send the video from the linked camera to the

secondary screen connected to the NVR through a

VGA port.

This option requires that a

secondary screen be

configured.

Note that you will view

the video in full screen

mode on the secondary

screen.

Link to Secondary Screen

HDMI2

Send the video from the linked camera to the

secondary screen connected to the NVR through an

HDMI port.

This option requires that a

secondary screen be

configured.

Note that you will view

the video in full screen

mode on the secondary

screen.

If the linked device is the NVR itself, the actions are as follows.

Action Description Remarks
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Action Description Remarks

Buzzer Enable the beeper on the NVR. -

E-Mail Send an alarm notification to the preset email address. To configure mail

settings, right-click the

NVR and choose

Settings >Mail Service.

Alarm Output X Invoke an alarm output device. -

5.9.2 Querying

Snapshots can be saved either locally (on the NVR Station) or remotely (on the NVR).

To query snapshots:

1. Right-click a camera and choose Search Snapshot, as shown in the following figure.

2. In the Search Snapshot dialog box, select a camera, an alarm type, a source, and a time, and then

click Search.

The following is an example.



In this step, you can perform the following operations:

 Download all or specific snapshots.

 Add or edit tags for a snapshot.

To find the snapshot save path on the NVR Station:

1. In the top right corner of the NVR Station, click the More button, as shown in the following

figure.

2. Click Settings.

3. Click the General tab, as shown in the following figure.
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5.9.3 Settings

To configure snapshot settings, right-click the NVR and choose Settings > Record and Snapshot >
Snap, as shown in the following figure.



5.10 Changing the Image Position

To change the image position, click the Fill, Stretch, or Original Size button on

the View tab page, as shown in the following figure.

Note

If you find you cannot change the image position, contact the system administrator to check whether the camera in

question supports the option. If so, contact the local authorized Sysvideo agent.
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5.11 Configuring Image Settings

For details on how to configure image settings for a camera, see section 5.3 "PTZ Controls."

5.12 Calling and Broadcasting

The NVR Station can enable an NVR to listen to or call a camera. The NVR Station can also start a

broadcast for an NVR. Before calling cameras or starting a broadcast, ensure that cameras are

equipped with audio output devices.

To call a camera, click the Initiate a call button at the bottom of its view window, as shown in the

following figure.

To terminate the call, click the Terminate a call button at the bottom of its view window, as shown

in the following figure.
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